untroduction to Presentation Software

Introduction

We communicate all the time, but relying on just one method is not always enough to get our
message across to varieties of audience. Imagine talking on the phone; we hear our friend, but we
cannot see his reactions. If we write a letter about our vacation workshop, its just words. But add a
picture, and our friend can start to visualize our fun and learning. Send a video clip, and he will get an
even clearer idea of everything we did in our workshop. Basically, the more ways we present
information, the stronger our communication becomes. This is the core idea behind multimedia:
using different elements to make our presentation more effective and informative.

In this chapter, we will learn how to create impactful digital presentations. We are already familiar
with LibreOffice. Impress is the presentation software offered by LibreOffice. Impress helps in
building everything from simple presentations to those with animations, graphs, tables, pictures,
lists and even interactive navigation. Impress has many features like attractive backgrounds, various
animation effects, powerful text formations, impactful transitions, colourful charts etc.

Multimedia

The word multimedia comes from “multiple” and “media”. Multimedia is about using more than one
type of media to represent an idea. Specifically, it brings together different elements like text, sound,
images, videos, and animated content. Multimedia helps organize messages, making them much
clearer for the audience. Different components of multimedia are shown in figure 9.1.

Multimedia

Figure 9.1 : Components of Multimedia

Digital Presentation

A digital presentation is the modern way to connect with an audience, using technology and software
to deliver information and ideas. It offers a more dynamic and engaging experience than the
traditional methods. For effective communication and audience engagement, digital presentations
are key in every environment, from business meetings to educational lectures and online events.
Digital presentations are visually appealing and interactive.

Introduction to Presentation Software

Presentation software is a type of computer program specifically designed to create, edit, and deliver
the digital presentations. With presentation software, we can create slide show, which is a series of
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connected slides. Each slide of a slide show can feature diverse multimedia components. This makes
presentations incredibly effective.

The market offers a wide array of excellent presentation software, with Microsoft PowerPoint,
Google Slides, Apple Keynote, Canva, and Prezi being some of the most popular examples. These
tools are packed with features and templates, enabling users to create rich, engaging slideshows with
ease. This chapter introduces Impress, the open-source presentation software included in the
LibreOffice suite.

Starting Impress
We can open the Impress in different ways:

) If the shortcut is created, we will find an icon for /mpress on the desktop. Double click
the icon to start the Impress.

° We can also click the Applications icon on the Ubuntu dashboard, then search for
Impress. Once the Impress icon appears, simply click it to launch the program.

When we open Impress, a blank slide appears on our screen, accompanied by various tools and
panels. Figure 9.2 illustrates this initial layout of Impress window.
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Letus explore each component of Impress window.

Title bar

The topmost bar of the Impress window is called the title bar. It displays the application name and a
title of our presentation. Since we have not saved our work yet, it will show “Untitled 1.” If we hover
our mouse over the title bar, we will see the menu bar and three window control buttons: Close,
Minimize,and Restore.
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Standard toolbar

The Standard toolbar, found right below the title bar, offers quick access to common commands like
New, Open, Save, Print, Cut, Copy, Paste, Undo, and Redo.

Line and Filling toolbar

This toolbar is used to control the visual appearance of drawing objects on our slides. It provides
quick access to options for modifying the lines and the fill of shapes.
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Master Pages: A slide master sets the text
style for titles and outlines, and it also defines .
. ] Figure 9.3 : Master Pages
the background design for every slide. If we
choose this option, we will see many predefined slides under Master Pages. These predefined slides
each have unique text styles and backgrounds. Among the available options, the default slide master

isablank template. Available Master Pages are shown in figure 9.3.
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Layouts: Choosing this option reveals various preformatted layouts, each with a different number
and size of placeholders. These placeholders let us insert various types of content, such as titles, text,
images, charts, tables, or even movies as shown in figure 9.4.
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Table Design: When we select the Table Design option, we will find a range of standard table styles
to choose from. We can also flexibly show or hide the highlighting of specific rows and columns.
Various table designs are shown in figure 9.5.

;Tl‘l'.ki View = X Tasks View = x
| b Master Pages ¥ Master Pages
|| Layouts B Layouts
|| & Table Design & Table Design
| @ Custom Anlmation B Custam Animation
| Madiry effect : = slide Transitlon
add._. Chanos Apply to selected slides
Mo Transitien ____E
Hemove Wipe Up
: Wwipe Right
Effect Wipe Lefl
L4 wipe Down
- wheel Clockwise, 1 Spoke -
Modify transition

pEtty speed | Medium

Sound | «ho Sounds

peed Loop until nest sour

Advance slide

@ Onmouse click
Aulomatically alter

(E8

Apply Lo All Slides

Change order: < . 4 Play Slige Show
b Slide Transition B Automatic proview
Figure 9.6 : Custom Animation Figure 9.7 : Slide Transition

140 Computer Studies : Std-9

Get More Learning Materials Here : & m @& www.studentbro.in



Custom Animation: Animation brings our slides to life by adding visual changes over time. In this
section, we can apply various animation effects to any selected object of our slide. We will find a
wide range of animations to choose from, and we can easily change or remove them later if needed.
Options available in Custom Animation are shown in figure 9.6.

Slide Transition: Slide transitions are the visual effects we see when moving from one slide to the
next during a presentation. We can apply these transitions to a single slide, multiple slides, or even
our entire presentation. If we prefer, we can also choose No transition for a simple, immediate switch
between slides. List of slide transitions is shown in figure 9.7.

Also, we have the control over the transition speed, with options for slow, medium, or fast.
Transitions can be set to occur automatically after a specific duration or manually by clicking.
Additionally, we can even add a sound to accompany our slide transition.

Drawing Toolbar

Below the main workspace, we will find the Drawing toolbar, packed with tools for creating all sorts
of visual elements. It includes options for basic shapes, arrows, connectors, symbols, block arrows,
callouts, stars, fontwork and many more.

Status bar

At the very bottom of the Impress window, we will find the Status bar. This bar displays key
information like the current slide number and the total number of slides. It also shows the name of the
selected master page and the zoom level. Plus, it even provides the coordinates of our mouse pointer
on the workspace and the area of any selected portion of our workspace.

Note: We can easily hide any toolbar or pane from the Impress window using the View menu
options. Conversely, if we need more tools, simply go to View — Toolbars to open additional
toolbars.

Creating first presentation

We have learned the basics of presentation software. Now, let us make first slide about our school in
Impress.

When we open Impress, we will see a default blank slide with two placeholders (See figure 9.2).
To make room for various types of content, we will start by changing the slide's layout.

Follow the steps to change the layout of our first slide:

) Click Layout section in Taskspane.

° Click Title and 2 Content layout.
Our slide will now display three placeholders: one for the title, and two positioned below it.
Follow the steps to insert the data in placeholders:

) Click the title placeholder and type the school's name.

° Click the bottom left placeholder and add any relevant text about the school.

) In the bottom-right placeholder, click the Insert Picture button. This will open the Insert
Picture dialog box. Navigate to the folder where our school's logo is saved, select the
file, and then click Open to insert the image into the slide.

Updated view of layout in the slide is shown in figure 9.8.
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Figure 9.8 : Updated View of Slide after Changing the Layout

To enhance our slide's visual appeal, we can easily change its master page. Follow the steps:

1.
options displayed.

slide.

Updated view after applying master page is shown in figure 9.9.

In the Tasks pane, click on the Master Pages section. We will see various master page
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Ready to see our slide in action? To view it as a full-screen slideshow, simply press the 5 function
key or select the Slide Show option from the Slide Show menu. Our slide will then be displayed in
full-screen mode, without the Impress window components visible.

To exit the slideshow and return to the Impress window, simply press the Escape key or right-click
anywhere and select End Show.

Inserting more slides in presentation

We have made the first slide. Now
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of the previous one. Keep in mind Modern School English 108
that while we can choose different Modem Highschool  English 9 to 12 (Science
layouts for individual slides, SIRLE BT
changing the master page on any “
slide will apply that change across h
allslides in our presentation. Figure 9.10 : Slide Showing the Sections of the School

Add another slide to our presentation and detail the different sections of the school. To make the
information more engaging, feel free to use elements like tables or pictures. We have used a table in
our example to organize the data, and we can see the result in the figure 9.10.

Let us add another slide to our presentation and detail the different activities of the school.Visuals

often convey ideas more effectively than text alone. We may create a slide for the school activities
that include relevant images with accompanying captions.

Insert a new slide by selecting Slide option from Insert menu. Select Title only layout for our slide
and insert the title: Activities. Now follow the steps to insert an image in your slide.

° Click on the Insert menu.

° Go to Picture and select From File option.

) In the Insert Picture dialog box that appears, locate and select our desired image file.
° Click Open button, and the image will be added to the slide.

Once we have inserted an image, we might need to adjust its size. To do this, click on the image to
select it. We will then see eight small green circles (edit points) appear around its edges. Simply drag
any of these green points inward or outward to resize the image. We can also drag the image to move
itto the perfect spot on our slide.

To add a caption, we will use a TextBox. Text box is a rectangular area where we can type the text.
First, select the Text tool from the Drawing toolbar. Then, click and drag below the image to create
the text box. Now we can type the caption. We will notice that the Line and Filling toolbar will be
replaced by formatting tools, allowing to customize the caption's appearance.
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Figure 9.11 shows a sample slide detailing the school's activities.
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Figure 9.11 : Slide Showing the Activities of School

We may create some more slides highlighting information about our school.We have added two
more slides on school results and school achievements as shown in figure 9.12 and figure 9.13.
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School Achievements I

—_—

h®

* Our NCC students are consistently selected for
national parades each year.

* Our cricket team won the inter-school championship.

* Our students earned medals in a variety of
competitions, includeing sports, essay writing and
many art competitions.

* Our students achieved top ranks in nearly all
centralized examinations.

Figure 9.13 : Slide Showing the School Achievements

As we can see, our fourth slide features a chart displaying the school results. Charts are excellent for
presenting data graphically, making it much easier to compare and understand trends than with plain

text or tables.

Now, let us explore how to insert a chart into our slide.

° Insert anew slide and select the 7itle, Content layout.

° Insert the title of slide.

° Click Insert Chart icon in Content placeholder. This action inserts a default chart, and

we will notice that the Chart toolbar appears directly above it.

° Click the Chart Data Table button on the Chart toolbar. A Data Table window will pop
up, displaying sample data. Simply replace this sample data with our actual figures as
shown in figure 9.14, then close the window. Our chart will then automatically update to

reflect the new values.

% Data Table

R
i [202223 | |fh [2023-24 | i [2024-29
Categories | Y-Values | Y-values | Y-Values |
1 |Class-9 |83 |86 |87.5
2 |Class-10 |81 85 88
3 |Class-115cience 87 |91 92.5
4 |Class-11Comm |85 90 93

Figure 9.14 : Data Table
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The slide with updated chart is displayed in figure 9.12. We may also consider adding more slides to
further elaborate on various aspects of our school's information.

Slide Views

LibreOffice Impress offers several different slide views; each designed for a specific purpose to help
us create and manage our presentations effectively. We can usually switch between these views
using tabs at the top of the Workspace area, or by going to the View menu.

Impress provides five views: Normal, Outline, Notes, Handout and Slide sorter. Let us briefly go
over the different ways we can view and work with the slides in Impress.

Normal view

Task of creating, formatting, and designing the slides are done using the Normal view. This is where
we will add the objects like text, graphics, video, animation etc. To work on a specific slide, just click
its thumbnail in the Slides pane, and it will appear in the main Workspace area of the Normal view. A
slide in Normal view is shown in figure 9.9.

Outline view

The OutlineView displays all the presentation slides in numbered order, but it focuses only on the text
content. We will see just the topic titles and any bulleted or numbered lists, all presented as left-
justified text. This view intentionally hides drawing objects, the text inside those objects, and even
the slide names, keeping the focus purely on our presentation's structure and content.

The OutlineView is used for quickly editing text across our slides. We can easily add or delete text,
move and copy content, and even change a paragraph's outline level using the left and right arrow
buttons as shown in figure 9.15.

Normal Outline Notes Handout Shide Sorter

=My School
* Dedicated to serving the
education sector for the

past century,

A cademics
A ctivities
+School Results
aSchooll

Achievements

* Dur NCC students are
consistently selected for
national parades each
year.

= Dur cricket team won the
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ranks in nearly all
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Figure 9.15 : Outline View
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Notes view

The Notes view is where we add personal notes to our slides. These notes are only for our reference
and won't appear during the slide show.To start adding notes, just click Click to add notes in the text
box below the slide, then begin typing. We can also resize the notes text box just like any other
window; simply place the pointer on its border and drag it to our desired size. These notes are
typically used to give the presenter extra information or reminders during the presentation. Notes
view is shown in figure 9.16.
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Figure 9.16 : Notes view
Handout view

The Handout view is primarily used for printing multiple slides on a single page, which is incredibly
useful for both the presenter and the audience. For the presenter, it is a great way to check the overall
appearance and flow of the slides when printed. For the audience, handouts provide a hardcopy of
the presentation's content, allowing them to follow along and take notes.

When we are ready to print, we will use the Handout view to set up the page layout, choosing how
many slides we want on each printed page. We can select from various layout options: 1, 2, 3,4, 6, or
9 slides per page, depending on our needs. Printing of Handout view is shown in figure 9.17.
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Figure 9.17 Handout View

This view displays all the slides as small thumbnails, giving us a complete overview of the
presentation. It is incredibly useful for rearranging slides with a simple drag-and-drop action, or for
applying changes to several slides simultaneously. Slide Sorter view is shown in figure 9.18.
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Figure 9.18 : Slide Sorter View
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Saving Presentation

Now that we have put work into our presentation, let us make sure it's saved for future use!
° Go to the File menu and select Save. We can also quickly save by pressing Ctr/ + S.
° Save As dialog box will pop up. Write aname in the Filename field.
° Click the Save button.

Our file will be saved as an Impress presentation, and the application automatically adds the .odp
extension to it. We can open our presentation at any time by simply selecting the Open option from
the File menu.

Summary

We explored the importance of digital presentations for effectively conveying ideas and learned how
to create them using Impress. We discovered that an Impress presentation is essentially a slideshow,
which is a compilation of interconnected slides. We practiced embedding multimedia objects into
the slides and experimented with various layouts and appealing master pages. Finally, we learned
how to display the presentations as a full-screen slideshow and utilize different slide views. In the
next chapter, we will explore some advanced Impress features that will help you create more

attractive and effective presentations by incorporating some special effects.

EXERCISE

What is a Multimedia? List the components of multimedia.

Why multimedia is important for communication? Give one example.

What is the importance of Digital presentation?

How can we start the Impress application in our Ubuntu system?

Make a list of components that are shown in the initial layout of Impress window.
Which sections are included in Tasks pane?

What is a Master page? Which master page is default in Impress?

Write a difference between Custom animation and Slide transition.

A A LR R o L

Write steps to insert an image in slide.

[
S

What is a chart? How can we insert a chart in a slide?

(S
(SN
.

State whether true or false.

(1)  We cannot change a slide master once it is chosen.
(2) Escape key can be used to end the full screen slide show.

(3) We can choose different layouts for our different slides in a presentation.
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“4)
)

Outline view in presentation software only shows images of the slides.

It is possible to arrange 7 slides on a single page using the Handout view.

12. Fill-in the blanks.

(1
2
3)
“4)
)

view is used to print multiple slides on a single page.
view is used for working on a specific slide.

Slide sorter view shows each slide in view.
view is used to add personal notes to a slide.

key is used to end the slide show.

13. Multi-choice questions. Choose the most correct answer.

(1)

2)

3)

(4)

)

(6)

(7)

(8)

Which out of the following is a presentation software?

(a) Impress (b) Writer (c) Base (d) Calc

The topmost bar of Impress window is known as...

(a) Status bar (b) Standard toolbar

(c) Title bar (d) Drawing toolbar

Which bar has the New, Open, and Save tool buttons?

(a) Drawing toolbar (b) Line and Filling toolbar

(c) Standard toolbar (d) Picture toolbar

Which part of the presentation software displays a thumbnail view of each slide?
(a) Tasks pane (b) Slide pane (c) Workspace (d) Status bar
Which panel has the subsections like Master pages, Layouts and Table Design?
(a) Tasks pane (b) Slide pane (c) Workspace (d) Status bar
Which out of the following is default slide master?

(a) Designed (b) Bordered (c) Blank (d) Highlighted
What is a visual change over time?

(a) Image (b) Audio (c) Text (d) Animation

Which is the visual effect you see when moving from one slide to the next during a
presentation?

(a) Slide Transition (b) Custom Animation

(¢) Slide Dynamism (d) Slide Transformation
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(9) Which bar of the Impress interface contains the zoom slider?
(a) Title bar (b) Menu bar
(¢) Standard toolbar (d) Status bar
(10) What is the shortcut key to begin a full-screen slide show?
(a) F3 (b) F5 (c) F7 (d) F10
Laboratory Exercise

1. Prepare additional slides for the existing school presentation, focusing on history of school,
achievements of students, faculties in each section etc.

2. Choose a mathematics theorem from your textbook and create a presentation that walks
through it step-by-step. Make sure to use the drawing toolbar effectively to create and display
all relevant images needed to explain the theorem.

3. Design a presentation showcasing India's diverse geography, religions, languages, and
cultures, and demonstrate how unity is maintained across these variations.

4.  Prepare apresentation showing importance of sports in a student's life.

5. Create a presentation detailing the causes of global warming, and also outline the actions we
should take and avoid to help protect the Earth from it.
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